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ABSTRACT

Sustainable forest management requires
accurate information on forest covers and
periodical changes. Availability and use of
spatial data has become very helpful in x-
raying structural changes in most tropical
rain forest management options due to
reliable accuracy of satellite images with
readily-available image processing tools.
Thus, we assessed forest drains and land-
cover changes in Shasha Forest Reserve
using Landsat TM, ETM+ and OLI/TC
images acquired from USGS. The images
were analyzed using ERDAS Imagine and
Maximum Likelihood Algorithm in ArcGIS
10.5. Land-use/cover change-dynamics were
characterized using Land Change Modeller.
Classification accuracies were assessed
using Kappa’s and confusion matrix.
Normalized Difference Vegetation Index
analysis was performed in ArcGIS. The
distinguished LULC were forest, farmland,
built-up and water bodies/swamp. The forest
cover and water bodies/swamp shrank by
638.91 and 1653.48 ha at -23.66 and -61.24
hayr?, respectively within the 27-year
period. Meanwhile, farmlands and built-up
areas increased by 1508.40 and 783.99 ha at
55.87 and 29.04 hayr™, respectively. Results
further showed that the reserve was better-
vegetated in 1991 (0.39) than 2018 (0.05).
The major drivers of forest degradation in the
area were subsistence agriculture, illegal
timber exploitation and overexploitation of
non-timber  forest  products.  Overall
classification accuracy was 95.1% with
Kappa’s coefficient of 0.9439. User’s
accuracy ranged between 90.8 and 96.2%,
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while Producer’s accuracies were between
90.8 and 98.1%. The result of LULC change
simulation showed that if the prevailing
trends subsist without regeneration, and if
other factors remained unchanged, forest and
water bodies/swamp would dip further by -
653.74 ha and -318.66 ha by 2050, while
farmlands and built-up areas would increase
by 622.62 ha and 349.78 ha, respectively,
with potential negative consequences on
environmental variables.

Keywords: Landsat images; land-use/cover
changes; fragmentation; consistent forest
losses.

INTRODUCTION

It will be impossible to separate the bond of
interactions  between man and the
environment. As man uses the resources
therein, there are negative consequences,
which might take decades to repair. The
resultant effects have been land-use and land
cover changes with wide-ranging effects on
both the culprit and the vulnerable. Since
return to democratic governance in Nigeria,
the country has witnessed monumental
losses in its areas under forest covers, mostly
by forest-dependent people. With poverty
rate on the rise coupled with very uncertain
political ~ futures,  governments  are
continually  relaxing  policies, which
favoured biodiversity conservation in the
past. At regional level, states have adopted
measures perceived to boost industrial
agriculture and promote internally-generated
revenue. These measures are very inimical to
forests and biodiversity conservation.
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Consequently, most of the reserved and
protected areas have been worse-hit, become
fragmented, and eventually de-gazetted in
favour of multinationals.

The use of remote sensing data is of immense
value in characterizing and monitoring
changes in vegetation patterns, deforestation
and forest degradation (Li et al. 2017).
Considering the palpable changes in most of
the forest reserves in Nigeria, it is important
to take advantage of remote sensing
technologies to ascertain the extent and rate
of natural forest conversion in the reserve.
This will help to sustainably manage the
forest biodiversity and preserve the state
heritage (Juliev et al. 2019). Such
information could fast-track  focused
decisions that would improve the conditions
of the forest reserve.

In the past, Osun State was known to contain
appreciable forest cover with many
important economic trees like Mansonia
altissima, Milicia excels, Khaya
grandifoliola among several others in larger
diameter categories, particularly Shasha
Forest Reserve. It was reputed to be one of
the richest remaining forests in south-west
Nigeria due to its biological diversity and
uniqueness. The reserve is, however,
threatened by illegal logging, over-hunting
and clearance for agriculture. This is evident
in the 2004 data used by Olokeogun et al.
(2014). Hitherto, little is known about the
extent of forest degradation in the reserve.
The only probable facts were that of farming
and continued illegal exploitations, which
were guessed to be negatively impacting the
health of the reserve. However, there is
dearth of sufficient data on forest
degradation from which reliable conclusion
can be drawn in order to formulate improved
strategies for forest conservation.

Also, the rates of forest cover depletions in
the past three decades are yet to be
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ascertained in the area. Therefore, we
assessed land-use and land-cover changes in
the reserve are assessed with a view to
understanding forest degradation rate and
profiling specific drivers of forest cover
losses in the area. The study also involves
simulation of possible future of the reserve
should the current circumstances persist.
Remote sensing and change detection studies
predominantly  focus on  providing
information on changing extents of and
patterns of land-use and land-cover changes
(Weng 2002). Effectiveness of Landsat TM,
ETM+ and OLI/TC data for land-use/cover
classification and change detection has
variously been exemplified (e.g., Yuan et al.
2005, Kabba and Li 2011, Mussa et al. 2017,
Othow et al. 2017, Bello et al. 2018, Jiménez
et al. 2018, Adeyemi and Adeleke, 2020,
Adeyemi and Ibrahim, 2020).

MATERIALS AND METHODS

Study Area
Shasha Forest Reserve (SFR) is located
between latitudes 6°55'00" and 7°1'00"N

longitudes 4°2'00" and 4°32'30"E in Osun
State, south-west Nigeria (Figure 1). The
reserve was first gazetted in 1925, as part of
the Old Shasha Forest Reserve under an
agreement with ljebu Native Authority. It
shares boundaries with Omo Forest Reserve
in the west. The northern and eastern
boundaries are with Ife Native Authority
Reserve and Oluwa Forest Reserve in Ondo
State. Shasha FR covers an area of 23,621.31
ha. Out of which about 1,559.8 ha are under
forest plantations of exotic and indigenous
tree species, including Gmelina arborea,
Tectona grandis, Pinus caribaea, Terminalia
spp. and Nauclea diderichii. The remaining
22,061.51 ha are now covered by pockets of
fragmented natural forests.
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Figure 1: Map of Shasha Forest Reserve

Annual rainfall ranges between 887 mm and
2,180 mm. The mean annual temperature is
about 26.5°C with annual range of between
19.5°C and 32.5°C. The rainy season in SFR
usually commences from March/April and
lasts till November. The original vegetation
structure of Shasha Forest Reserve is multi-
layered with scattered emergent. The reserve
is subdivided into Area 4 and Area 5. The
soils belong to the highly ferruginous
tropical red soils associated with basement
complex rocks. As a result of the dense
humid forest cover in the area, the soils are
generally deep and of two types, namely,
deep clayey soils formed on low smooth hill
crests and upper slopes, and the sandier hill
wash soils on the lower slopes.

Image Datasets

The study involved the use of multi-temporal
Landsat images for land-cover classification
and change detection analysis. Landsat TM,
ETM+ and OLI/TC satellite images of 4 age-
series acquired from the United States
Geological Survey (USGS) through Earth
Explorer were used for the study (Figure 2).
Among all the available satellite data, the
scenes chosen are presented in Table 1. The
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satellite images were obtained during dry
season for each year, between December and
January (i.e. 1991, 2002, 2014 and 2018).
Satellite images were selected to fall near
anniversary  windows to allow for
comparison of vegetation phenology and
minimises discrepancies in reflectance,
which could result from seasonal variations
in vegetation and water regimes, as well as
differences in sun angle, as observed by
Coppin et al. (2004). This choice of dry
season in image selections was also guided
by sensitivity to cloud cover, which could
obscure terrain information in satellite
scenes. The 1991, 2014 and 2018 images
were geometrically corrected to a common
Universal Transverse Mercator coordinate
system, Datum WGS 1984; Zone 32N, based
on a 1:50,000 topographic map scales with
the 2002 image as the master. Each of the
four image-types was resampled to produce
region of interest (ROI), using the steps in
subsequent sections.

For Landsat 8 OLI/TC of 2014 and 2018,
Bands 5 (NIR): 0.85-0.88 um, 4 (red): 0.64-
0.67 um and 3 (green): 0.53-0.59 pm were
combined (stacked) together to form a single



multi-spectral image dataset
following steps in ArcGIS 10.5:

using the

Arctool Box
» Data Management Tools
» Raster
P Raster Processing
» Composite Bands
» Band Selection in this order
» 54,3
» OK
» Done.

For each Landsat image, the pre-processing
operations performed consist of atmospheric
correction, radiometric corrections and
extraction of region of interest (i.e., the study
area to be analyzed) or sub-setting, as
follows:

Spatial Analyst Tools
» Extraction
P Extraction by Mask
» Input raster file
» (i.e., the composite image)
P Input feature mask (select the vector or
enveloped file, as the case may be)
» Ok.

For Landsat 7 images, however, gap filling
was done for each of the bands before band
combination to remove scanline errors as
follows:

ArcTool Box
» Landsat Toolbox
» Fix Landsat 7 Scanline Errors
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» Ok
» done.

These procedures were repeated for Landsat
7 ETM+ image of 2002 using band
combination 4,5,3 and 4,3,2 for Landsat 5
TM of 1991 image.

Image Pre-processing

The Landsat images were level-1 products,
implying that they were already corrected for
geometric accuracy by the data provider.
However, to maximize the use of all spectral
information contained in the satellite images,
image pre-processing including atmospheric
correction, radiometric calibration and image
sub-setting performed in ERDAS Imagine
2014 Software. Prior to image classification,
ground-truthing of relevant land-cover and
land-use types within the study area was
done. Field data were collected using Global
Positioning System (GPS) Receiver for
collection of coordinates at various locations
within the study area. This involves the use
of random points generated during first stage
of image processing using Landsat 8 OLI/TC
image of 2018 (prior to fieldwork).

Table 1: Characteristics of satellite images used for the study

Sensor Band Wavelength (um) Resolution  Year Date
Band 1-Blue  0.45-052 30
Band 2 - Green 0.52-0.60 30

Landsat5 (TM) 5.4 3 - Red 0.63 - 0.69 30 1991  05/01/1991
Band 4 - NIR 0.76 - 0.90 30
Band 1-Blue  0.45-052 30
Band 2 - Green 0.52 - 0.60 30

Landsat 7 (ETM+) 5143 - Red 0.63 - 0.69 30 2002 03/01/2002
Band 4 - NIR 0.77 - 0.90 30
Band 2 - Blue 0.452 - 0.512 30
Band 3 - Green  0.533-0.590 30

Landsat8 OLITC oo 44 Red  0.636-0.673 30 2014  30/12/2014
Band5-NIR  0.851-0.879 30

Landsat 8 OLI/TC Band 2 - Blue 0.452 - 0.512 30
Band 3 - Green  0.533 - 0.590 30 2018  04/01/2018
Band4-Red  0.636-0.673 30
Band5-NIR  0.851 - 0.879 30

30
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2014 Landsat OLI/TC

2018 Landsat OLI/TC

Figure 2: Extracted images of the study area for the four datasets

Image Analysis and LULC Classification

Supervised (maximum likelihood)
classification method was adopted. The
image pixels were grouped into finite classes
based on their spectral signatures (land-cover
classes). This was achieved using Maximum
Likelihood Algorithm. Maximum likelihood
classification (MLC) was preferred because
it takes the variability of the classes into
account by using the covariance matrix
(Morgan et al. 2015; Ayele et al. 2018), and
it is also the most-accurate algorithm in
ERDAS Imagine. A total of four land-use
and land-cover types were distinguished (i.e.
forest, farmland, built-up area and water
bodies/swamp). The accuracy assessment of
the classified layers was done using
independent training data collected during
field surveys.
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The dynamics of land-use and land-cover
changes were analyzed using Land Change
Modeler (LCM) by IDRISI (2014). The
LCM tool was used to analyze changes in the
forest landscape over four periods: 1991-
2002, 2002-2014 and 2014-2018. The Land
Change Modeler was adopted and applied for
the Land-use/land-cover changes analysis
due to its capacity to execute accurate
automated decision support system. It
simplifies the complexities of change
analysis, and allow for rapid analysis of land-
cover dynamics, enable the establishment of
empirically modelled relationships to
explanatory variables, and simulate future
land change scenarios.

Vegetation Index

The Normalised Difference Vegetation
Index (NDVI) is one of the oldest, well-




known, and most-frequently used VI. The
combination of its normalized difference
formulation and use of the highest absorption
and reflectance regions of chlorophyll make
it robust over a wide range of conditions. It
was computed as:
PNIR—pRED
PNIR+pRED
Where:

pnirand prep = reflectance at near infrared
and red wavelength bands, respectively

Although NDVI values range between -1 and
1. The common range for green vegetation is
0.2 to 0.8. The NDVI was used to measure
changes in green vegetation.

The Change Matrix

The first step in change detection was raster
to vector conversion, as follows:

NDVI = (1)

Arctool Box
» Conversion Tools
» From Raster
» Raster to Polygon
» Input Raster (include class in the attribute
table of the raster data)
» Select the class created in the raster
» Ok
» done.

The second step was dissolution of the vector
data (polygon). This was done following the
steps:

Geoprocessing
» Dissolve (the 1988, 1999, 2002, 2013 and
2018 images done separately)
» Input feature class (select the vector file to be
dissolved)
» Ok
» done.
The third step was unification or to unify the
three images or datasets (1988, 1999, 2002,

2013 and 2018 images), as follows:

Geoprocessing
» Union
» Input feature class (select the three
dissolved vector files for 1991, 2002, 2014
and 2018)
» Ok
» done.
Then open the attribute table of the unified
vector (shapefile)

» Add another field (Area)
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» right-click on the field

» Calculate Geometry

» Yes

» Change the unit to hectare
» Ok

» Yes

» Export the attribute table
» Table Options

» Export

» Change the file extension to dBASE Table
> Save

» OK

» No

» done.

The exported file was then opened in excel.
The next thing was to make pivot table for
the four years, and the differences in land-
use/land-cover over the period was then
determined using appropriate statistics. The
determination of losses and trend analysis
over 27-year period was obtained from the
change matrix table. The net gains or losses
to persistence ratio of each of the LULC
types between 1991 and 2002, 2002 and
2014, 2014 and 2018 were determined. The
mathematical computations were then done
as follows:

Trend
ALULC = L, — L, (2)
Where:
L2 (ha) = final year;
L. (ha) = initial year.
Rate of Change
Ry = ((Lz — L) % %) 3)

Where: t (year) = periodic interval

Projection
A, = <(Rt. t x L1/100) + L1> (4)
PT = Az + Ri (5)
Where:

P = predicted area increase;

A, = predicted year’s trend,

L, = land-use/land-cover of base year
(1991);

R; = the rate of change of LULC in 28
years;



Ri =
projection.

ratio increase; t = years of

Classification Accuracy

The overall accuracy of land-use/land-cover
classification was done by creating a
confusion matrix in ArcMap 10.5 using
ground reference points obtained during
ground-truthing, and following these steps:

Spatial Analyst Tools

» Extraction

» Extract Multi Values to Points

» Input point features (input the Ground-truth
GPS points collected on the field)

P Input raster (input the classified image)

» Ok

» done.

The attribute table was then exported (in
dBASE format) for further analysis of the
confusion matrix to determine classification
accuracy and Kappa Coefficient. A total of
600 ground-truthed points (locations) were
used for accuracy assessment of the land-
use/land-cover classification. A total of 600
points were also created in the classified
image of the study area to generate the cell
array for confusion matrix table (as done by
Adeyemi and Ibrahim (2020). Accuracy was
computed by dividing the total correctly-
classified pixels by the total number of pixels
in the confusion  matrix.  Overall
classification accuracy was then determined

by:
Y =

n
Zi=1xi

Z j=1 X j
Where:
Y = overall accuracy,

x; = the i correct point, X

; = total number of all points.

x 100 (6)

Other statistics used for accuracy assessment
included sensitivity (producer’s accuracy),
specificity, commission error, omission error,
users’ accuracy and Kappa’s coefficient (K)
as follows:

Producer's Accuracy = - (7)
) y w+x

User's Accuracy = v (8)
e e s z

Specificity = — 9
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(10)

Ommission Error = 1 — Producer's accuracy

(11)

Where:

w = number of times a classification agreed
with the observed value;

x = number of times a point was wrongly
classified;

y = number of times a point was correctly
classified;

z =number of times a point was not classified
as ‘x’ when it was not observed to be ‘x’.

Commission Error = 1 — Specificity

Kappa’s coefficient measures perfect
agreement between prediction and reality or
classification results and the real
observation, as is the case in this study. It was
computed as:

K
_ NZ?j:lxij _Z}ﬂjzl(xij + Xx,q)

(12)
N2 ¥l ioq (xij Xx44)
Where:
r = number of rows and columns in error
matrix;

N = total number of observations (pixels);

Xij = observations in the ith row and jth
column;

X+i = marginal total of the ith row;

X+j = marginal total of the jth column.

Kappa Coefficient ranges between O and 1. A
Kappa coefficient of 1 implies perfect
agreement, while any value nearing zero
means that the agreement between prediction
and reality or between classification and real
observation is no better than that due to
chance.

RESULTS

Land-use and Land-cover Classes of
Shasha Forest Reserve

The classification of the four (4) images in
the age-series yielded land-cover maps of the
study area and from these; four (4) LULC
classes were identified. The characteristics of
these land-cover types are described in Table
2.
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Table 1: Description of different LULC categories

LULC Description

Built-up area Area densely covered by road, buildings and other infrastructure.
Farmland Lands used for cultivation of subsistence and/or commercial agriculture.
Forest Natural forest and artificial forest i.e. Plantation in the reserve.

Water bodies/Swamps

Main water bodies and wetlands that are forested in the study area.

LULC Status

Figure 3 presents the multi-temporal LULC
with four major classes, viz: forest, farmland,
built-up area and water bodies/swamps of
1991, 2002, 2008 and 2018. In 1991, forest
occupied 19,042.38ha (80.6%). This was
followed by water bodies/swamps with
3,574.89 ha, (15.1%), which was scattered
around the north, south, east and the western
parts of the area. Farmland covered 531.9 ha
(2.3%) of the area, located mainly around the
northern part of the reserve. Built-up areas
were least with 472.14 ha (2.0%). In 2002,
forest increased to 19,894.77 ha (84.2%),
with concentration in most part of the reserve
except in an area dominated by water
bodies/swamps that occupied 1,653.21 ha
(7.0%), less than 50% of its original extent.
Farmland increased to 1,247.94 ha (5.3%),
and built-up area also surged to, 825.39 ha
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(3.5%) with concentration within the region
where people farm and very few scattered
ones in other areas. In 2014, forest occupied
20,934.45ha (88.6%) with an increase of
4.4% in twelve years (from the previous
period). Water bodies/swamps, however
declined by 1.8% to 1,223.82ha (5.2%)
within the same period. Farmland covered
843.93 ha (3.6%) representing a decline of
1.7% from previous period. Similarly, built-
up area contrasted by 0.9% to 619.11 ha
(2.6%). Between 2014 and 2018,
forest sharply contrasted by 10.7% to
18,403.47 ha (77.9%) of the land area.
Farmland gained 5.1% to occupy 2040.30 ha
(8.7%) within the period. Water
bodies/swamps was up by 2.9% with
1921.41 ha (8.1%). There was also an
increase of 2.7% in built-up area at 1256.13
ha (5.3%) within that period (Figure 3).
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Figure 3: LULC change in Shasha Forest Reserve between 1991 and 2018

Land-use/Land-cover Change Trends in
Shasha Forest Reserve between 1991 and
2018

The LULC changes between 1991 and 2018
in Shasha forest reserve are presented in
Table 3. On the whole, forest decreased by
638.91 ha (2.7%) over the 27 years period.
This translates to an annual loss of 23.66 ha.
Farmland gained 1,508.4 ha (6.4%) in 27
years. This translates to an annual gain of
55.86 ha. Built-up areas increased by 783.99
ha (3.3%) between the assessment period at
an annual gain of 29.04 ha. Nevertheless,
water bodies/swamps shrank by 1653.48 ha
(7.0%) at an annual loss of 61.24 ha. From
1991 to 2002, forest, farmland and built-up

areas experienced a positive change of
852.39 ha (3.6%), 716.04 ha (3.0%), 353.25
ha (1.5%), respectively while water
bodies/swamps experienced a decline of
1921.68 ha (8.1%). Between 2002 and 2014,
forest has its area experiencing a positive
change of 1039.68 ha (4.4%), while that of
farmland, Dbuilt-up areas and water
bodies/swamps  experienced  negative
changes of 404.01 ha (1.7%), 206.28 ha
(0.9%), 429.39 ha (1.8%). From 2014 to
2018, however, forest experienced its most
negative change of 2530.98 ha (10.7%),
while farmland, built-up areas and water
bodies/swamps were positively impacted
with 1196.37 ha (5.1%), 637.02 ha (2.7%)
and 697.59 ha (3.0%), respectively.

Table 3: Land-use and Land-cover change trend in SFR between 1991 and 2018

Area extent

LULC change

1991 2018 1991-2018 Rate
LULC Area (ha) % Area (ha) % Avrea (ha) % hayr?
Forest 19,042.38 80.6 18,403.47 77.9 -638.91 -2.7 -23.66
Farmland 531.90 2.3 2,040.30 8.6 1,508.40 6.4 55.87
Built-up areas 472.14 2.0 1,256.13 5.3 78399 3.3 29.04
Water bodies/Swamps 3,574.89 15.1 1,921.41 8.1 -1,653.48 -7.0 -61.24

Normalized Difference Vegetation Index
(NDVI)

Table 4 shows that the reserve was more
vegetated in 1991 than any other period of
assessment. The study shows that vegetation
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index decreased over the 27 years period
from 0.38 in 1991 to 0.05 in 2018. The
maximum NDVI (0.38) was found in 1991,
which indicated an increase in vegetation.
The lowest NDVI1 (0.05) was found in 2018,



indicating that other LULC types increased
in that year to the detriment of forest
vegetation cover. This ranged between 0.39
in 1991 to 0.05 in 2018. The NDVI value
below zero i.e., in 2014 and 2018 indicated
increases in water bodies/swamps (Figure 4).
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Figure 4: NDVI map of Shasha Forest Reserve

LULC Classification Accuracy Results

The results of the accuracy assessments
obtained from random samplings for the
classified images showed overall accuracy
values of 95.1% (Table 5). User’s accuracy
ranged between 90.8 and 96.2% while
Producer’s accuracy values were between
90.8 and 98.1 %. The narrow range of
accuracy indicates a less-severe confusion of
built-up area with other land-use and land-
cover classes. Besides, the high Producer’s
accuracy values reflect the accuracy of
prediction of each of the LULC classes. The
User’s accuracy reflects the reliability of the
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Table 4: NDVI analysis result for Shasha
Forest Reserve

Year Minimum  Maximum
1991 0.12 0.38
2002 0.16 0.35
2014 -0.19 0.08
2018 -0.08 0.05
+ 2002
-
[
2018
"

classification to the user, and is a more
relevant measure of the classification’s
actual utility on the field. The commission
and omission errors were less than 10%, and
they reflect the points, which were included
in the category while they really did not
belong to that category and those omitted in
their specific land-use or -cover classes,
respectively. The overall Kappa’s coefficient
for the reserve is 0.9439.



Projected Land-use and Land-cover in
Shasha Forest Reserve

Spatial projections of areas under threat of
degradation are shown in Figure 5, which

Table 5: LULC classification accuracy results
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depicts the pattern of changes for the LULC
types. The projection was set for a period of
12, 22, and 32 years from base year (2018).

Confusion Matrix

Built-up Water
LULC areas bodies/Swamp Farmland Forest Row total
Built-up areas 51 2 0 0 53
Water bodies/Swamp 1 69 6 0 76
Farmland 0 2 59 0 61
Forest 0 2 71 73
Column total 52 73 67 71 263

Accuracy assessment result

LULC UA CE PA OE
Built-up areas 96.2 3.8 98.1 19
Water bodies/Swamp 90.8 9.2 93.2 55
Farmland 93.7 6.3 90.8 9.2
Forest 96.1 3.9 97.3 2.7
Overall accuracy 95.1
Kappa’s coefficient 0.9439

20000 -
18000 -
16000 -

Forest Farmland

LULC

Built-up Water bodies/swamp

Figure 5: Future projection for the LULC types in Shasha Forest Reserve

DISCUSSION

The serial decline in natural forest and
swamps over the 27-year period was
observed to result from encroachment and
illegal exploitation of timber in the area. It
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also appears that politics might have played
a role in forest decline. For instance, there
were gains in forests, and the water
bodies/swamps appeared relatively stable
between 2002 and 2014. The later four years



of that period corresponds to the first regime
of the immediate past governor, who was
well-reputed for his outstanding passion for
a safe environment and forest. However, the
second regime, between 2014 and 2018, was
marked by low internally-generated revenue
and dwindling economic fortunes of Osun
State, where the reserve is situated.
Consequently, there were heavy forest
encroachment and illegal exploitations in the
reserve by unauthorized low-income earners
and other civil servants, whose incomes were
heavily impacted due to irregular salaries,
probably to get alternative survival means.
Other drivers of forest degradation in the
area include conversion of forests to
farmland for subsistence as well as
infrastructural building and roads to connect
human settlements to local markets. Adedeji
and Adeofun (2014) have reported a trend for
the reserve due to perceived conversion of
forest to other uses, especially the plantation
of exotic timbers such as Tectona grandis,
Gmelina arborea and Pinus species. This
also corroborates the findings of Adekunle
(2006). A large part of the reserve, which
was a good repository of plant and animal
species, was de-reserved for the
establishment of monoculture plantations.
Among the factors responsible for the
increasing trend of forest plantation in the
area was attributed to be their ability to
produce high amount of biomass within a
relatively short period of time to the
detriment of indigenous wood species and
losses of valuable biodiversity.

In a study carried out in the study area by
Oates et al. (2014), it was noted that the
decline in natural forest was mostly due to
population expansion, rapid urbanization and
non-supervision  from the concerned
authorities such as forest guards with people
erecting buildings, de-reserve the reserved
area to non-forest uses without checks.
Although there was a general increase in the
size of the forest plantation between 2002
and 2014, which contributed to forest size
within the period, the gains recorded were
lost in four years (between 2014 and 2018)
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with most parts of the plantation being
degraded by illegal loggers through serial
exploitation of Gmelina arborea trees for
industrial wood products as a result of low
income generation by state government,
which further pushed the illegal operators
back to forest, ditto for the unpaid
government agents, who were expected to
protect the forest. Unfortunately, forest
conversions have potential consequences on
soil conditions, and geomorphology of the
area, increase runoff and sedimentation of
the river system. Hence, the reduction in the
sizes of water bodies/swamps.

Areas once covered by forests are now
occupied by either water bodies/swamps,
farmland or building infrastructure in 2018
due to population expansion and increasing
rate of poverty in the state, which may pose
the risk of flooding. This is consistent with
the report of Yu and Suganda (2012), who
noted that vegetation cover decreases if
factors like population expansion exist. The
major drivers of forest loss in the area were
subsistence agriculture in unauthorized areas
and illegal timber exploitations. Farmlands
are replacing vegetation cover at a rate too
difficult for resilience. There were also signs
of illegal timber extractions, which
contributed greatly to forest losses during the
period.

When simulated, the result showed that if the
trend continues, forest and water
bodies/swamps would further shrink in sizes
beyond the areas they currently occupied,
while farmland and built-up areas would
claim more of those areas in the forest
reserve land in the next few decades, a
development inimical to biodiversity and
sustainability. Population expansion might
mean that more land would be needed to
meet food and wood needs of the rural
populace in the area, and if not checked, may
result in total loss of the reserve within few
years. This corroborates the finding of
Adubofour (2011), who attributed losses in
forest reserve to incessant conversions to
other land uses due to rapid and uncontrolled



population growth as well as the need for
human survival.

CONCLUSION AND
RECOMMENDATIONS

The result has shown that the reserve
changed tremendously over 27-year period.
The changes resulted in fragmented patches
of forest. Consequently, forest covers and
water bodies/swamps shrank in extents due
to serial and consistent conversions for
residential and subsistence agricultural
purposes. Large areas were left un-
regenerated, thus exposing the lands to
further degradations while giving liberty to
the subsistence farmers to colonize the fallow
area. Hence, farmland and built-up area have
become more perennial than forest land-use
in the last two decades. It is most likely that
forests and water bodies/swamps would
decline in extents. Meanwhile, farmlands
and built-up areas would rise and claim more
land in the near future, possibly denuding the
area of appreciable forest cover. This
worsens the environmental situation in the
area with consequences like losses of vital
biodiversity component, siltation of water
bodies and the eventual flood disasters,
engineered by anthropogenic forces.

It therefore becomes expedient to promote
protection of existing natural forest cover to
prevent further drains, while considering
reliable alternative livelihood means for the
forest-dependent people in the interest of
sustainability. However, the illegal loggers
would need to be handled with tougher
measures like arrest and prosecution to serve
as deterrent to the potentials dealers. In the
case of regeneration and forest management
in general, we suggest “plant as you log”
measure. For instance, fifty seedlings of
same species as those logged could be
planted to ensure retainance of natural forest
and indigenous species. We discovered that
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monoculture plantations already mimicked
the natural forest during image analyses,
reducing species diversity, and this poses the
risk of further losses of native species in the
near future.
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